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MODULE 4: MICROSOFT DYNAMICS NAV CLIENT 
INSTALLATION 

Module Overview 
In the previous modules, you have seen that Microsoft Dynamics NAV 2013 
supports multiple client types. All client types can be installed by using Microsoft 
Dynamics NAV 2013 Setup.  

Although the Development environment and NAS services are also considered as 
Microsoft Dynamics NAV 2013 clients, they are not described in this module. The 
module "Microsoft Dynamics NAV Server" describes how to install and manage 
NAS services. The Development environment is described in the module "The 
Developer Environment".  

The Microsoft Dynamics NAV Administration Tool is a Microsoft Management 
Console (MMC) snap-in for creating and managing Microsoft Dynamics NAV 
Server instances. Therefore, it is not considered a Microsoft Dynamics NAV client. 
The tool is described in the module "Microsoft Dynamics NAV Server".  

Microsoft Dynamics NAV 2013 uses the Microsoft software platform. Therefore, all 
the software prerequisites of Microsoft Dynamics NAV are part of the Microsoft 
software stack. For a list of software requirements for the different client types, see 
the module "Installation Requirements."  

Objectives 

The objectives are:  

• Install Microsoft Dynamics NAV 2013 in a stand-alone environment. 

• Install Microsoft Dynamics NAV 2013 RoleTailored clients for 
Windows on a network. 

• Install Microsoft Dynamics NAV Web client. 

• Install Microsoft Dynamics NAV Portal Framework for Microsoft 
SharePoint. 

• Install additional languages. 

• Explain how to configure the Microsoft Dynamics NAV RoleTailored 
client for Windows to support WAN connections. 

• Explain how to install additional interface languages for Microsoft 
Dynamics NAV 2013.  
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Install the RoleTailored Client for Windows 

Run Setup 

Microsoft Dynamics NAV 2013 can be installed on a single computer to create a 
stand-alone environment for demonstration and development. You can run 
Microsoft Dynamics NAV Setup and select the Install Demo option to create a 
stand-alone environment. When you select this option, the following components 
are installed on the computer: 

o RoleTailored client for Windows  

o Development environment  

o Microsoft Dynamics NAV Server  

o Demo database and demo license 

In addition, Microsoft® SQL Server® 2008 Express Edition is installed if the 
computer does not already have Microsoft SQL Server installed. 

However, when you deploy Microsoft Dynamics NAV 2013, you typically do not 
run the Install Demo option on each client computer in the network because you 
do not have to have a data and a server tier on each client computer. Instead, you 
install one of the client types on the client computers and then connect to the 
server tier.  

The RoleTailored client for Windows (and the other client types) can be installed 
by using Microsoft Dynamics NAV 2013 Setup. When you install Microsoft 
Dynamics NAV 2013, you can select from several prepackaged installation options 
(each designed for a typical use or type of user) or you can perform a customized 
installation that fully meets your needs.  

To install the RoleTailored client for Windows, select one of the following 
installation options: 

• Client 

• Developer  

• Custom 

The installation option determines which components are installed on the 
computer. For example, if you install the Client option, the RoleTailored client for 
Windows is installed without the Development environment. With the Developer 
option, the RoleTailored client for Windows, the Development environment, the 
Documentation, and the Microsoft Dynamics NAV Administration components are 
installed on the client computer.  
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    Note: To install the Microsoft® Office Outlook® Add-In for Microsoft 
Dynamics NAV 2013, you must install Microsoft Office Outlook before you install 
the RoleTailored client for Windows. 

After you install the product, you can start the RoleTailored client for Windows on 
the Start menu. 

Documentation 

The Documentation component includes several technical documents that can be 
very useful for Microsoft Dynamics NAV administrators, developers, and 
application setup consultants: 

• Application Guides: this folder contains several documents that can 
help when you set up companies in Microsoft Dynamics NAV. 

• Developer Guides: the Developer and IT Pro Help (devitpro.chm).  

• Install Guides: the Hardware Sizing Guide for Microsoft Dynamics NAV 
and the Security Hardening Guide. 

When you install the Document component, you can specify the destination 
folder for the documents on the Specify parameters page. The default folder is 
C:\Program Files (x86)\Microsoft Dynamics NAV\70, but you can change this.  

Adding and Removing Product Components 

If you want to add new Microsoft Dynamics NAV components and features on a 
computer that already contains some components, you have to run Microsoft 
Dynamics NAV Setup again on that computer. Microsoft Dynamics NAV Setup 
automatically checks for existing components and starts in Maintenance mode.  
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FIGURE 4.1: MICROSOFT DYNAMICS NAV SETUP WINDOW IN 
MAINTENANCE MODE 

In Maintenance mode, you can select from three options: 

Option  

Add/Remove Components Use this option to add or remove 
Microsoft Dynamics NAV product 
components. It also lets you customize 
how your installed programs run. 
Newly selected components are added; 
cleared components are removed. 

Repair Use this option to repair the Microsoft 
Dynamics NAV installation. This can be 
useful if the installed program files are 
corrupted. 

Uninstall Use this option to remove Microsoft 
Dynamics NAV from your computer.  

When you select Add/Remove Components, Microsoft Dynamics NAV Setup first 
shows you the Customize the installation page (where you can select additional 
components or clear existing components) and then the Specify Parameters 
page (where you can enter specific configuration parameters for the newly added 
components). After you specify the necessary parameters, you can either Save the 
configuration to a file or click Apply to start the installation. 
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    Note: When you uninstall Microsoft Dynamics NAV 2013, the Microsoft 
Dynamics NAV database is not removed. You must remove it manually. The same 
applies to the Microsoft Dynamics NAV license file and any other software 
prerequisite for Microsoft Dynamics NAV (for example, the Microsoft .NET 
Framework 4.0). 

Demonstration:  Install the RoleTailored Client for 
Windows in a Network 

This demonstration shows how to install the RoleTailored client for Windows in a 
network. 

Demonstration Steps 

1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 
drive. 

a. Open the DVD drive by pressing the Eject button on the physical 
drive. 

b. Put the DVD on the tray. 
c. Press the Close button to close the DVD drive. 

 
2. Start Microsoft Dynamics NAV Setup. 

a. Open Windows Explorer. 

b. Select Computer to see a list of available drives. 
c. Select the DVD drive that contains the Product DVD.  
d. In the root folder of the selected drive, double-click setup.exe. 
e. If the Open File - Security Warning message appears (asking 

whether you want to run the setup.exe application), click Run. 
 

3. Select the Client installation option. 
a. In the Welcome to the Microsoft Dynamics NAV 2013 Setup 

window, click Next. 
b. On the Microsoft Software License Terms page, click I Accept.  
c. On the Microsoft Dynamics NAV Setup page, click Select an 

Installation Option. 

d. On the Choose an installation option page, click Client. 
e. On the Specify parameters page, in the Server Name field, type 

the name of the computer where the Microsoft Dynamics NAV 
Server instance you want to connect to is installed. 
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f. In the Service Name field, type the name of the Microsoft 
Dynamics NAV Server instance to which you want to connect.  

g. Select Apply to start the installation. 
Setup now installs the RoleTailored client for Windows. 

Demonstration:  Install the Development environment 

By default, when you install the RoleTailored client for Windows by using the 
Client installation option, the Development environment is not installed. This 
demonstration shows how to add the Development environment to a computer 
that is running the RoleTailored client for Windows.  

Demonstration Steps 

1. Insert the Microsoft Dynamics NAV 2013 Product DVD in the DVD 
drive. 
a. Open the DVD drive by pressing the Eject button on the physical 

drive. 

b. Put the DVD on the tray.  
c. Press the Close button to close the DVD drive. 

 
2. Start Microsoft Dynamics NAV Setup. 

a. Open Windows Explorer. 
b. Select Computer in the left pane to see a list of available drives. 
c. Select the DVD drive that contains the Product DVD.  
d. In the root folder of the selected drive, double-click setup.exe. 

e. If the Open File - Security Warning message appears (asking 
whether you want to run the setup.exe application), click Run. 
 

3. Add the Development environment (C/SIDE) component. 
a. On the Maintenance page, click Add or remove components. 
b. On the Customize the installation page, double-click the Client 

node to expand it.  

c. Click the icon at the left of the Development environment 
(C/SIDE) item.  

d. Click Run from My Computer.  
e. On the Customize the installation page, click Next. 
f. On the Specify parameters page, click Apply. 

Microsoft Dynamics NAV Setup now adds the Development 
environment and all prerequisite software components. 
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Set Up Configuration Files 

When you install the RoleTailored client for Windows, you must select the 
components to install and specify several setup parameters to be saved to a client 
configuration file.  

In larger networks, you have to select the components and enter the parameters 
on each RoleTailored client  for Windows computer. This can be very time 
consuming and easily lead to typing errors (causing incorrect configurations).  

To streamline the setup process, Microsoft Dynamics NAV Setup lets you capture 
and save a set of setup decisions (such as the components to install and the 
parameters to use) to a Setup configuration file. You can then distribute this 
configuration file and use it on any other computer to install the RoleTailored 
client for Windows. Instead of selecting the components one by one and 
specifying all the parameters manually, you load the Setup configuration file and 
continue Setup.  

    Best Practice: In large networks, we recommend that you copy the Microsoft 
Dynamics NAV 2013 product DVD to a shared network folder that can be accessed 
from all clients. You might add a separate folder that contains the Setup 
configuration files for your convenience. 

Modify a Setup Configuration File 

If you have to change an existing Setup configuration file, you can run Microsoft 
Dynamics NAV Setup on a computer without any Microsoft Dynamics NAV 
components installed. You can load it into Setup, make the desired modifications, 
and then save it. You do not have to install any software during this process. 

Setup configuration files can also be used to install Microsoft Dynamics NAV 
Setup from the command line. This is illustrated in the next lesson. 

Run Setup on the Command Line 

Microsoft Dynamics NAV 2013 Setup can also be run from a command prompt. 
On the Microsoft Dynamics NAV installation media, setup.exe is in the root 
directory. To start Microsoft Dynamics NAV Setup from the command line, follow 
these steps: 

• Open a command prompt. 

• Run setup.exe from the Microsoft Dynamics NAV 2013 installation 
media. 
This opens the Microsoft Dynamics NAV Setup wizard. 
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    Note: If User Access Control is turned on, you must open the command 
prompt with administrative credentials. To do this, click Start > All Programs > 
Accessories. Right-click Command Prompt, and then click Run as administrator. 

You can use the following options with setup.exe. 

Setup Option Description 

/config <setup configuration 
file> 

Specifies path and file name 
information for a Microsoft Dynamics 
NAV 2013 Setup configuration file to 
load. 
This is the only required option. 

/help Displays Help about setup.exe 
options. 

/log <log file> Specifies path and file name 
information for a Setup log file to be 
created by Setup. The file must not 
exist before you run Setup. 

/quiet Specifies that Setup does not display 
anything on the screen. All 
configuration information is taken 
from the specified configuration file. 

/repair Repairs the current installation of 
Microsoft Dynamics NAV 2013. 

/uninstall Removes the current installation of 
Microsoft Dynamics NAV 2013. 

Install Business Web Service Components 
Microsoft Dynamics NAV business web services are considered a client because 
they interact with the Microsoft Dynamics NAV database through Microsoft 
Dynamics NAV Server. However, unlike other client types, business web services 
cannot be installed as a separate component in Microsoft Dynamics NAV Setup: 
they can only be installed as part of the Microsoft Dynamics NAV Server 
component. In other words, if you want to install the Microsoft Dynamics NAV 
business web services on a computer, you have to install the Microsoft Dynamics 
NAV Server component first. After that, you can use the Microsoft Dynamics NAV 
Administration Tool to enable business web services (SOAP web services or OData 
web services).  
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Install Business Web Services 

For more information about how to install and administer Microsoft Dynamics 
NAV, see the module "Microsoft Dynamics NAV Server".  

After you have installed the Microsoft Dynamics NAV Server and enabled web 
services, you can publish Microsoft Dynamics NAV pages, codeunits, and queries 
as web services by using the RoleTailored client. 

SOAP and OData Web Services 

Web services are a lightweight, industry-standard way to make application 
functionality available to many different external systems and users. Microsoft 
Dynamics NAV 2013 supports creation and publishing of Microsoft Dynamics NAV 
functionality as web services. You can expose pages, codeunits, or queries as web 
services, and even improve a page web service by adding an extension codeunit. 
When you publish Microsoft Dynamics NAV objects as web services, they are 
immediately available on the network. 

Developers can publish two types of web services from Microsoft Dynamics NAV 
objects: 

• SOAP Web Services. You can publish either Microsoft Dynamics NAV 
pages or codeunits as SOAP services. 

• OData Web Services. You can publish either pages or queries as 
OData services. 

OData web services are a new addition to Microsoft Dynamics NAV 2013, 
complementing the SOAP web services that have been available in earlier 
versions. A developer who plans to create Microsoft Dynamics NAV web services 
may have to decide which type of web service is better suited to the company's 
needs.  

SOAP Web Services 

SOAP web services provide full flexibility for building operation-centric services. 
They provide industry standard interoperability. Windows Communication 
Framework (WCF) has supported SOAP services since its initial release in the .NET 
Framework 3.0, and .NET 4 adds more support and default bindings to make it 
easier to build SOAP services using WCF.  

The most common messaging pattern in SOAP is the remote procedure call (RPC), 
where one network node (the client) sends a request message to another node 
(the server), and the server sends a response message to the client. 
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OData Web Services 

The OData standard is good for web service applications that require a uniform, 
flexible, general purpose interface for exposing create retrieve update delete 
(CRUD) operations on a tabular data model to clients. OData is less appropriate 
for applications that are primarily RPC oriented or in which data operations are 
constrained to certain prescribed patterns. OData supports Representational State 
Transfer (REST)-based data services. These enable resources, identified using 
Uniform Resource Identifiers (URIs) and defined in an abstract data model (i.e. the 
Entity Data Model (EDM)), to be published and edited by web clients within 
corporate networks and across the Internet by using simple HTTP messages. 
OData services are lightweight, with functionality frequently referenced directly in 
the URI. 

.NET Framework 4.0 is enhanced with WCF Data Services, which implement all the 
non-NAV-specific parts of the OData stack. Visual Studio service references 
“understand” OData services and can generate EDM-based proxies. This enables 
the developer to use LINQ to write the data access logic. 

Whereas SOAP web services expose a WSDL document, OData web services 
expose an EDMX document that contains metadata for all published web services.  

OData is supported in PowerPivot, a data-analysis add-in to Microsoft Excel 2010 
that provides enhanced business intelligence capabilities. PowerPivot supports 
sharing and collaboration on user-generated business intelligence solutions in a 
Microsoft SharePoint Server 2010 environment. For more information about 
PowerPivot, see http://www.powerpivot.com/. 

The extensions to the Atom Publishing Protocol that are defined in the AtomPub 
extensions to the OData protocol documentation describe how REST-based data 
services can enable resources. These are identified by using URIs and defined in an 
abstract data model (EDM), to be published and edited by web clients within 
corporate networks and across the Internet by using simple HTTP messages.  

In addition to the AtomPub format, the OData implementation in Microsoft 
Dynamics NAV 2013 also supports the JSON format, a somewhat less verbose 
format that may perform better in low-bandwidth environments. 

Publish a Web Service 

After you create a web service in the RoleTailored client, you must publish the 
web service so that it is available to service requests over the network. Users can 
discover web services by pointing a browser or a tool such as Visual Studio at the 
computer that is running Microsoft Dynamics NAV Server and requesting a list of 
available services. When you publish a web service, it is immediately available over 
the network for authenticated users. All authorized users can access metadata for 
Microsoft Dynamics NAV web services, but only users who have sufficient 
Microsoft Dynamics NAV permissions can access actual data. 
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    Note: Codeunit and Page are valid object types for SOAP web services. Page 
and Query objects are valid types for OData web services. 

Demonstration:  Publish a Page as Web Service 

This demonstration shows how to publish a Page object as a web service. The 
page is then available as both an OData and a SOAP web service. 

Demonstration Steps 

1. Publish a Web service. 

a. Open the RoleTailored client for Windows and connect to the 
CRONUS International Ltd. demonstration company. 

b. In the Search box on your Home page in the RoleTailored client 
for Windows, type "Web services" and then press Enter.  
The Web Services page opens. 

c. In the Web Services page, click New. 
d. In the Object Type column, click Page, and then type “21” in the 

Object ID column and “Customer” in the Service Name column.  

    Note: The service name is visible to consumers of your web service and is the 
basis for identifying and distinguishing web services. So, you should make the name 
meaningful. If you are setting up integration with Microsoft Outlook by using 
codeunit 5313, then you must use DynamicsNAVsynchOutlook as the service 
name. 

e. Select the check box in the Published column.  
f. Click OK to exit the New - Web Services page.  

Verify Web Service Availability 

After you publish a web service, it is available on the Microsoft Dynamics NAV 
Server instance to which you were connected when you published. The web 
service is available across all Microsoft Dynamics NAV companies on the server 
instance, not just the one that the RoleTailored client was using to publish the 
web service. 
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    Note: After publishing a web service, verify that the port that web service 
applications use to connect to your web service is open. The default port for SOAP-
based web services is set to 7047. The default port for OData-based web services is 
7048. The value can be configured by using the Microsoft Dynamics NAV 
Administration Tool. For more information about this tool, see the module 
"Installation Requirements". 

You can verify the availability of the web service by using a browser. 

    Note: You must modify your Internet Explorer settings to display the actual 
XML for a feed instead of the feed content that has changed. To turn off the feed 
reading view, click Tools > Internet Options > Content > Feeds and Web Slices 
> Settings and clear the Turn on feed reading view check box. Restart Internet 
Explorer to enable the new setting. 

Verify Availability of an OData Web Service 

To check the availability of OData web services on a Microsoft Dynamics NAV 
Server, follow these steps: 

1. Start Internet Explorer. 
2. In the Address field, enter a URI in this format: http:// 

<Server>:<WebServicePort>/<ServerInstance>/OData.  
For example:  http://localhost:7048/DynamicsNAV/OData 

    Note: The company name is case-sensitive. It is optional if you only want to 
verify the availability of SOAP web services. When you use the web service to access 
data in the Microsoft Dynamics NAV database, you must include the company 
name.  

The browser should now show the web service that you have published, in the 
format of an AtomPub document: 
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FIGURE 4.2: LIST OF AVAILABLE ODATA WEB SERVICES 

The figure List of Available OData Web Services shows two OData web services: 
Customer and Company.  

To view the customers for a specific company in the database, you have to enter 
the URI in this format: 

http:// 
<Server>:<WebServicePort>/<ServerInstance>/OData/Company(‘<CompanyNa
me>’)/<CustomerWebServiceName>  

The following URI can be used to retrieve data from the CRONUS International 
Ltd. company through the OData web service called Customer: 

http://localhost:7048/DynamicsNAV/OData/Company('CRONUS 
International Ltd.')/Customer 

Verify Availability of a SOAP Web Service 

To check the availability of SOAP web services on a Microsoft Dynamics NAV 
Server, follow these steps: 

1. Start Internet Explorer. 

2. In the Address field, enter a URI in this format: http://< 
Server:WebServicePort>/<ServerInstance 
>/WS/<CompanyName>/Services  
For example:  http://localhost:7047/DynamicsNAV/WS/CRONUS 
International Ltd./Services 

    Note: The company name is case sensitive. It is optional if you only want to 
verify the availability of SOAP web services. When you use the web service to access 
data in the Microsoft Dynamics NAV database, you must include the company 
name.  
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The browser should now show the web service that you have published, in the 
format of an XML document: 

 

FIGURE 4.3: LIST OF AVAILABLE SOAP WEB SERVICES 

The figure List of Available SOAP Web Services shows two SOAP web services: 
Customer and SystemService.  

SystemService and Company Services  

You can use the SystemService service in a SOAP web service application to 
retrieve a list of companies available in a specific database. A company name is 
typically part of the URI when you access a Microsoft Dynamics NAV web service, 
and the system service lets you retrieve names of available companies.  

Similarly, you can use the Company service in an OData web service application to 
retrieve a list of companies in a specific database.  

Install Web Client 
You install the Microsoft Dynamics NAV Web client on a computer that is running 
Internet Information Services. For the Microsoft Dynamics NAV 2013 Web client to 
work correctly, you must have a working connection to a Microsoft Dynamics NAV 
Server instance that connects to a Microsoft Dynamics NAV database.  

The following figure shows the components involved in the setup: 

 

FIGURE 4.4: MICROSOFT DYNAMICS NAV WEB CLIENT SETUP WINDOW 
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Set Up Web Client 

To install Microsoft Dynamics NAV Web client, run Microsoft Dynamics NAV 2013 
Setup. The Web client can be installed only as part of a Custom installation option.  

 

FIGURE 4.5: INSTALLING THE MICROSOFT DYNAMICS NAV WEB CLIENT 
WINDOW 

The Microsoft Dynamics NAV Web Server components can be installed only on a 
computer on which the following programs are present: 

• Microsoft Internet Information Server (IIS) 

• ASP.NET 

• Windows Authentication 

Setup installs a website for Microsoft Dynamics NAV Web client on an Internet 
Information Services server and configures the connection from Microsoft 
Dynamics NAV Web client to Microsoft Dynamics NAV Server. By default, Setup 
configures the Microsoft Dynamics NAV Web client to connect to a Microsoft 
Dynamics NAV Server instance on the same computer. The instance has the 
following default parameters: 

• Server name: localhost 

• Service instance: DynamicsNAV 

• Service port: 7046 
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However, you can change the default values during Setup. The connection 
information is saved in the web.config file of the Microsoft Dynamics NAV Web 
client site.  

You can install Microsoft Dynamics NAV Web client on the same computer as the 
Microsoft Dynamics NAV Server or a separate computer. If you install Microsoft 
Dynamics NAV Web client on a different computer than Microsoft Dynamics NAV 
Server, then you must set up delegation between the Microsoft Dynamics NAV 
Web client and the Microsoft Dynamics NAV Server. For more information, see Set 
Up Delegation later in this lesson. 

Configure after Setup 

After installation, you can change the configuration by modifying the web.config 
file. 

The web.config file is an .xml file that you can edit by using a text editor, such as 
Notepad. By default, the web.config file is located in the C:\Programs 
(x86)\Microsoft Dynamics NAV\70\Web Client folder. 

    Note: After you modify the web.config file, if you have Microsoft Dynamics 
NAV Web client open in the Internet browser, the changes do not take effect until 
you close the browser and then reopen Microsoft Dynamics NAV Web client. 

Please be aware that all values must be enclosed in quotation marks. 

The Microsoft Dynamics NAV Web client settings are included in the 
<DynamicsNAVSettings> tag in the web.config file. The following table describes 
the settings that are available in the <DynamicsNAVSettings> tag. 

Setting Description 

AllowNtlm Specifies whether NT LAN Manager (NTLM) fallback is 
permitted for authentication. 

To require Kerberos authentication, set this value to false. 
Values: true, false 
Default value: true 

ClientServicesChunkSize Sets the maximum size, in kilobytes, of a data chunk that is 
transmitted between Microsoft Dynamics NAV Web client 
and Microsoft Dynamics NAV Server. Data that is 
transmitted between Microsoft Dynamics NAV Web client 
and Microsoft Dynamics NAV Server is broken down into 
smaller units called chunks, and then reassembled when it 
reaches its destination. 
Values: From 4 to 80. 

Default: 28. 

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Module 4: Microsoft Dynamics NAV Client Installation 

4 - 17 

Setting Description 

Company Sets the company to which Microsoft Dynamics NAV 
connects. If you do not define a company, then the system 
uses the company currently used by the RoleTailored client 
for Windows for the user. 
Values: A company defined in the Microsoft Dynamics NAV 
solution. 

Default value: none 

ClientServicesCompressionTreshold Sets the threshold in memory consumption at which 
Microsoft Dynamics NAV Web client starts compressing 
data sets. This limits amount of consumed memory. The 
value is in kilobytes. 
Default: 64 

TimeZone Sets the time zone for Microsoft Dynamics NAV Web 
client. The time zone applies to all date and time data that 
a user views or enters in the Microsoft Dynamics NAV Web 
client. 
Values: A time zone that is included in the registry of the 
computer that is running Microsoft Dynamics NAV Web 
client. You find the time zones in the registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Time Zones. The value must match a 
time zone that is listed in the registry. For example, you 
can set the value to "Pacific Standard Time" or "Central 
Europe Standard Time." 

Default value: UTC 

Language Sets the language version of Microsoft Dynamics NAV 
objects to display in Microsoft Dynamics NAV Web client.  

Values: Any languages that are available for the Microsoft 
Dynamics NAV solution. 
Default value: en-US 
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Setting Description 

OpenConnectionTimeout Specifies the maximum time allowed to establish a 
connection from the Microsoft Dynamics NAV Web client 
to the Microsoft Dynamics NAV Server before the session is 
ended.  
The time has the format [dd.]hh:mm:ss[.ff]: 
• dd is the number of days 

• hh is the number of hours 

• mm is the number of minutes 

• ss is the number of seconds 

• ff is fractions of a second 

If you do not want a time-out, then set the value to 
MaxValue. 
Default value: 00:00:30 

ClientServicesProtectionLevel Specifies the security services used to protect the data 
stream between the Microsoft Dynamics NAV Web client 
and Microsoft Dynamics NAV Server. This value must 
match the value that is specified in the Microsoft Dynamics 
NAV Server configuration file. For more information, see 
Configuring Microsoft Dynamics NAV Server 
Values: EncryptAndSign, Sign, None 
Default value: EncryptAndSign 

Server Specifies the name of the computer that is running the 
Microsoft Dynamics NAV Server. 
Default value: localhost 

ServerInstance Specifies the name of the Microsoft Dynamics NAV Server 
instance to which the Microsoft Dynamics NAV Web client 
connects. 
For more information, see the Microsoft Dynamics NAV 
Server module of this course. 

Default value: DynamicsNAV 
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Setting Description 

ClientServicesCredentialsType Include this key only when the Microsoft Dynamics NAV 
Web client uses form-based authentication to authenticate 
users.  

Specifies how Microsoft Dynamics NAV Web client users 
are authenticated when they connect to Microsoft 
Dynamics NAV Server.  

Set to Windows to use Windows authentication. Users' 
Windows logon credentials are used. Therefore, users are 
not prompted for a user name or password. 
Set to UserName to authenticate users with a user name 
and password that is set up in Microsoft Dynamics NAV. 
When users try to access Microsoft Dynamics NAV Web 
client, they are prompted for a user name and password. In 
Microsoft Dynamics NAV, the user name and password 
that is provided by a user is authenticated against an 
Active Directory user. This setting can be used with form-
based authentication.  
Set to NavUserPassword to authenticate users on a user 
name and password that is set up in Microsoft Dynamics 
NAV. When users try to access Microsoft Dynamics NAV 
Web client, they are prompted for a user name and 
password. The difference between NavUserPassword and 
UserName is that with NavUserPassword, a user is 
authenticated directly against the user name and 
password, whereas with UserName the user is 
authenticated against a Windows account in Active 
Directory. 
You must also configure the 
ClientServicesCredentialType parameter in Microsoft 
Dynamics NAV Server to match the value in the Microsoft 
Dynamics NAV Web client configuration file. See the 
module "Microsoft Dynamics NAV Server". 
Values: Windows, UserName, NavUserPassword 

Default value: Windows 

ClientServicesPort Specifies the TCP port for the Microsoft Dynamics NAV 
Server. This is part of the Microsoft Dynamics NAV Server’s 
URL. 
Values: 1-65535 
Default value: 7046 
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Setting Description 

ServicesPrincipalNameRequired If this parameter is set to true, then the Microsoft 
Dynamics NAV Web client can only connect to a Microsoft 
Dynamics NAV Server instance that is associated with a 
service principal name (SPN). 
If this parameter is set to false, then the Microsoft 
Dynamics NAV Web client tries to connect to the 
configured Microsoft Dynamics NAV Server service, 
regardless of whether that service is associated with an 
SPN. 
Default: false 

SessionTimeout Specifies the maximum time that a connection between 
the Microsoft Dynamics NAV Web client and the Microsoft 
Dynamics NAV Server can remain idle before the session is 
ended.  
In the Microsoft Dynamics NAV Web client, this setting 
determines how long an open Microsoft Dynamics NAV 
page or report can remain inactive before it closes. For 
example, when the SessionTimeout is set to 20 minutes, if 
a user does not take any action on a page within 20 
minutes, then the page closes and the following message 
appears: "The page has expired and the content cannot be 
displayed." 
The time span has the format [dd.]hh:mm:ss[.ff]: 
• dd is the number of days 

• hh is the number of hours 

• mm is the number of minutes 

• ss is the number of seconds 

• ff is fractions of a second 

Default value: 00:20:00 

HelpURL Specifies the URL that is opened by the Microsoft 
Dynamics NAV Help action in Microsoft Dynamics NAV 
Web client. By default, the URL targets the Microsoft 
Dynamics NAV 2013 Help in the MSDN library at 
www.msdn.com. This is a public website, so to view the 
Help, users must have permission to access the Internet or 
the default help URL as a minimum. 
Values: A valid URL 

Default value: 
http://go.microsoft.com/fwlink/?LinkID=233742 
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Setting Description 

DNSIdenitity Specifies the subject name of the service certificate for 
Microsoft Dynamics NAV Server. The Microsoft Dynamics 
NAV Web client makes sure that the certificate that is 
provided during the SSL handshake contains a Domain 
Name System (DNS) or CommonName (CN) attribute that 
is equal to the DNS identity of the client. This check is 
performed in addition to determining the validity of the 
server certificate. 
Default value: There is no default value for this parameter 

For example: The Microsoft Dynamics NAV Server to which the Microsoft 
Dynamics NAV Web client connects is configured in the web.config file for the 
Microsoft Dynamics NAV Web client. If you want to connect the Web client to 
another database, you can change the Microsoft Dynamics NAV Server instance 
by modifying the web.config.  

On the computer that is running Microsoft Dynamics NAV Web client, use any 
text editor, such as Notepad, to open the web.config file for edit. 

By default, the web.config file is located in the \Programs (x86)\Microsoft 
Dynamics NAV\70\Web Client folder. 

1. Locate the <NAVSettings> element. 
2. Change the values for the ClientServicesPort, Server, and 

ServerInstance elements. 

Install IIS for Web Client 

The Microsoft Dynamics NAV Web client requires IIS version 7.0 with the following 
features enabled: 

• .NET Extensibility 

• ASP .NET 

• ISAPI Extensions 

• ISAPI Filters 

• Request Filtering 

• Windows Authentication 

• Static Content 

This topic describes how to install and configure Internet Information Services for 
the Microsoft Dynamics NAV Web client. The procedure is slightly different for 
Windows 7 and Windows Server 2008 R2. 
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Install IIS on Windows 7 

1. To install IIS on Windows 7, follow these steps: Click Start  > Control 
Panel > Programs.  

2. Under Programs and Features, select Turn Windows features on or 
off. 

3. In the Windows features list, expand Internet Information Services, 
and then expand World Wide Web Services. 

4. Expand Application Development Features, and select the 
following features: 

o .NET Extensibility  

o ASP .NET  

o ISAPI Extensions 

o ISAPI Filters  
 

5. Expand Security, and then select the following features:  

o Request Filtering  

o Windows Authentication  
 

6. Expand Common HTTP Features, and then select the Static Content 
feature.  

7. To install Internet Information Service (IIS) Manager, under Internet 
Information Services, expand Web Management Tools, and then 
select IIS Management Console.  
This step is optional. You use Internet Information Service IIS Manager 
to manage local and remote web servers and sites. 

8. Click OK to complete the installation.  
9. To verify that the web server is installed correctly, start your browser 

and then type "http://localhost" in the address field. 

The default website opens and should display an IIS 7 image. If the IIS 7 image 
does not appear, then verify that you have configured static content on IIS, as 
described in steps above. 

    Note: To open Internet Information Services (IIS) Manager, on the Start 
menu, in the Search Programs and Files box, type "inetmgr", and then press 
ENTER. 
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Install IIS on Windows Server 2008 R2 

To install IIS on Windows Server 2008 R2, follow these steps : 

1. Click Start  > All Programs > Administrative Tools > Server 
Manager. 

2. In the navigation pane, click Roles and then click Add Roles. 

3. In the Before You Begin window, click Next. 
4. In the Select Server Roles window, select Web Server (IIS) and then 

click Next two times. 
5. In the Select Role Service window, expand Common HTTP 

Features, and then select Static Content. Other features that are 
selected by default can remain selected. 

6. Expand Application Development Features, and select the 
following features: 

o ASP.NET  

If a message displays asking to add role services for ASP.NET, click 
Add Required Role Services. 

o .NET Extensibility 

o ISAPI Extensions  

o ISAPI Filters  

If a dialog box appears that asks you to confirm ASP.NET, click Allow 
to continue.  

7. Expand Security, and then select the following features: 

o Windows Authentication  

o Request Filtering  

8. Expand Management Tools, and then click IIS Management 
Console.  
This step is optional. You use IIS Manager to manage local and 
remote web servers and sites. 

9. Click Next, confirm your selections, and then click Install to complete 
the installation.  

10. When the installation is complete, click Close.  

11. To verify that the web server is installed correctly, start your browser, 
and then type "http://localhost" in the address field. 

The default website opens and should display an IIS 7 image. If the IIS 7 image 
does not appear, then verify that you have configured static content on IIS, as 
described in the steps above. 
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    Note: Internet Information Services Manager was also installed. To verify the 
installation, click Start  > Administrative Tools > Internet Information Service 
(IIS) Manager. 

Set Up Delegation 

When the client device, Microsoft Dynamics NAV Web client, and Microsoft 
Dynamics NAV Server are on separate computers, the client device interacts with 
Microsoft Dynamics NAV Server through the computer that is running Microsoft 
Dynamics NAV Web client. Microsoft Dynamics NAV Web client is performing 
actions on the client device's behalf. This process is known as impersonation. 
Impersonation cannot be used across multiple computers. Therefore, you must set 
up delegation from Microsoft Dynamics NAV Web client to Microsoft Dynamics 
NAV Server.  

Delegation occurs when a front-end service (such as Microsoft Dynamics NAV 
Web client or Microsoft Dynamics NAV Portal Framework for SharePoint 2010) 
forwards a client device request to a back-end service (in this case the Microsoft 
Dynamics NAV Server service) so that the back-end can impersonate the client 
device. Impersonation is typically used to check whether a client is authorized to 
perform a particular action, whereas delegation is a way of flowing impersonation 
capabilities, together with the client’s identity, to a back-end service. You can use 
delegation as a Windows domain feature with Kerberos-based authentication. 

Configuring delegation means explicitly configuring the Microsoft Dynamics NAV 
Server service to delegate its access to the database server on behalf of Microsoft 
Dynamics NAV Portal. To make the access more secure, specify delegation to a 
specific service on a specific server.  

To complete the procedure in this topic, you must be a domain administrator. 

To set up delegation from the front-end (running SharePoint or the Web Server 
Components) to the Microsoft Dynamics NAV Server, follow these steps  

1. On any server in the domain, click Start and then click Run. 
2. In the Open field, type"dsa.msc". 

This opens the Active Directory Users and Computers utility.  

3. In the navigation pane on the left, expand the node for the domain 
where you have installed the Microsoft Dynamics NAV environment.  
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4. To configure delegation, the functional level for the domain must be 
Windows Server 2003 or a later version. To verify the domain 
functional level, right-click the node for the domain where you have 
installed Microsoft Dynamics NAV, and then click Raise Domain 
Functional Level. If the level is not at least Windows Server 2003, 
then raise it to that level.  

5. Expand the Computers node, right-click the computer that is running 
Microsoft Dynamics NAV Portal, and then click Properties.  

6. On the Delegation tab, click Trust this user for delegation to 
specified services only, and then click Use Kerberos only.  
You must add the following services for the computer that is running 
Microsoft Dynamics NAV Server: 

Service Type User or Computer Port 

DynamicsNAV NAVSERVER 7046 

Host NAVSERVER  

NAVSERVER is the name of the computer that is running Microsoft 
Dynamics NAV Server.   

7. To add the services, click Add. 

8. In the Add Services window, click Users or Computers. 
9. In the Enter the object names to select box, type the name of the 

Microsoft Dynamics NAV Server computer and then click OK.  

10. In the list of available services, press and hold the CRTL key, select 
DynamicsNAV for port number of the Microsoft Dynamics NAV 
Server and HOST, and then click OK. 

11. Click OK to close the dialog box. 
 

    Note: If the account running the Microsoft Dynamics NAV server does not 
have sufficient credentials to register an SPN on startup, a message is added in the 
Windows Event Log of the NAV Server computer and the SPN must be registered 
manually. 
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Install Portal Framework for SharePoint 2010 

What Is Microsoft Dynamics NAV Portal Framework for 
SharePoint 2010? 

Microsoft Dynamics NAV Portal Framework for Microsoft® SharePoint® 2010 is a 
web-based application framework for integrating Microsoft Dynamics NAV with 
Microsoft SharePoint 2010 applications. This enables users to interact with 
Microsoft Dynamics NAV data from a web browser. With Microsoft Dynamics NAV 
Portal Framework, you can display Microsoft Dynamics NAV pages and reports on 
SharePoint sites from which users can view, edit, and manage Microsoft Dynamics 
NAV data. 

Microsoft Dynamics NAV Portal Framework is a set of components that you install 
on a server or servers running Microsoft SharePoint Foundation 2010. Then you 
use the Microsoft Dynamics NAV Portal Framework to build SharePoint web 
applications that display Microsoft Dynamics NAV pages and reports.  

Developers of solutions for Microsoft Dynamics NAV Portal Framework have the 
same experience as those using the RoleTailored client. Developers create 
Microsoft Dynamics NAV objects in the development environment and implement 
the same metadata and business logic as RoleTailored client. A page or report that 
can be displayed in the RoleTailored client can also be displayed on a SharePoint 
site.  

End-users can work with Microsoft Dynamics NAV data in a familiar SharePoint 
environment that uses the same appearance and behavior. Working with 
Microsoft Dynamics NAV pages and reports in SharePoint resembles working with 
the pages and reports in the RoleTailored client. 

Microsoft Dynamics NAV Portal Framework is designed for occasional users who 
typically need an overview of their daily work status and perform fairly simple or 
light data entry. 
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Prepare the Installation 

Microsoft Dynamics NAV Portal Framework connects to a Microsoft Dynamics 
NAV database through a Microsoft Dynamics NAV Server instance. Microsoft 
Dynamics NAV Setup configures the connection to the Microsoft Dynamics NAV 
Server.  

If you are installing Microsoft Dynamics NAV Portal Framework on a different 
computer than Microsoft Dynamics NAV Server, then you have to provide 
information about Microsoft Dynamics NAV Server during setup.  

If you are installing Microsoft Dynamics NAV Portal Framework on the same 
computer as Microsoft Dynamics NAV Server, then Setup automatically detects 
the Microsoft Dynamics NAV Server instance. Therefore, you do not have to 
provide any information unless you want to use another instance. 

Before you start to install the Portal Framework, you must follow these steps: 

1. Verify the system requirements are met on the computer that you 
want to install Microsoft Dynamics NAV Portal Framework.  

2. Obtain the following parameters for Microsoft Dynamics NAV Server. 

Parameter Description 

Server Name The name of the server that running Microsoft 
Dynamics NAV Server. The default is localhost. 

Server Instance 
Name 

The instance of Microsoft Dynamics NAV Server to 
which the Portal Framework will connect. The default 
is DynamicsNav. 

Server Port The communication port that is used by Microsoft 
Dynamics NAV Server. The default is 7046. 

3. If you are installing Microsoft Dynamics NAV Portal Framework on a 
specific web application on the SharePoint server, then obtain the 
port number that the web application uses.  

To obtain the port number of a SharePoint web application, follow these 
steps: 

1. On the computer that is running Microsoft SharePoint 2010, click 
Start > All Programs > SharePoint 2010 Central Administration.   

2. Click Manage Web Applications to display a list of all the SharePoint 
web applications.  

3. In the Port column, locate the port number for your web application. 
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Install Portal Framework for the First Time 

This topic describes how to install Microsoft Dynamics NAV Portal Framework for 
the first time on one or more Microsoft SharePoint applications. To install 
Microsoft Dynamics NAV Portal Framework, run Microsoft Dynamics NAV Setup 
on the Microsoft SharePoint server farm or stand-alone server. Setup installs 
Microsoft Dynamics NAV Portal Framework on the web applications on the 
SharePoint server farm or stand-alone server. 

For more information about Microsoft SharePoint, see 
http://go.microsoft.com/fwlink/?LinkId=267426. 

The following figure shows the components involved with the setup of Microsoft 
Dynamics NAV Portal Framework. 

 

FIGURE 4.6: THE MICROSOFT DYNAMICS NAV PORTAL FRAMEWORK ARCHITECTURE 

When you run Setup, you have three options for installing Microsoft Dynamics 
NAV Portal Framework: 

• Install Microsoft Dynamics NAV Portal Framework on a new 
SharePoint application. 

This option creates a new SharePoint web application on the local 
SharePoint server farm or stand-alone server and installs the 
Microsoft Dynamics NAV Portal Framework. This option does not 
create any sites in the site collection of the newly created web 
application. You must create the SharePoint sites manually. 

• Install Microsoft Dynamics NAV Portal Framework on all web 
applications on the local SharePoint server farm or stand-alone server.  
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This does not include administrative web applications, such as the 
SharePoint Central Administrator. 

• Install Microsoft Dynamics NAV Portal Framework on a specific web 
application on the local SharePoint stand-alone server. 

Setup installs a SharePoint solution package for Microsoft Dynamics NAV Portal 
Framework on the server farm or stand-alone server. SharePoint Server deploys 
and activates the Microsoft Dynamics NAV Portal Framework solution package on 
each web application that you have selected. After you run Setup, you can deploy 
and activate Microsoft Dynamics NAV Portal Framework on additional web 
applications by using SharePoint Central Administration. 

To install the Microsoft Dynamics NAV Portal Framework for SharePoint, follow 
these steps : 

1. On the computer that is running SharePoint Server, insert the 
Microsoft Dynamics NAV installation media into a drive, or browse to 
the directory that contains the Microsoft Dynamics NAV 2013 Setup 
program.   

2. Double-click the setup.exe file to start the Microsoft Dynamics NAV 
Setup wizard. If you have already installed one or more Microsoft 
Dynamics NAV components on the computer, you see the 
Maintenance page instead of the Welcome page. In this case, click 
Add or remove components, and then skip ahead to the Customize 
the Installation page step. 

3. Click Next.  
4. To accept the license terms, click I accept.  
5. On the Microsoft Dynamics NAV Setup page, click Choose an 

installation option.  
6. On the Choose an Installation Option page, click Custom.  
7. On the Customize the Installation page, select the check box next 

to Portal Framework for SharePoint, and then click Run from My 
Computer.  

8. Click Next to open the Specify parameters page.  
9. On the Specify parameters page, under Server, set the Server 

Name, Service Name, and Server Port fields for the Microsoft 
Dynamics NAV Server instance to which you want to connect.  

10. Under SharePoint Components, do one of the following:  
o To create a new web application on the SharePoint server and 

install Microsoft Dynamics NAV Portal Framework for the new 
web application, set the Web Application parameter to Install 
for a new web application. The remaining parameters are not 
used. 
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    Note: A port number is automatically assigned to the web application by 
SharePoint Server.  

 To install Microsoft Dynamics NAV Portal Framework for all 
web applications on the SharePoint server, set the Web 
Application parameter to Install for all web applications. 
The remaining parameters are not used. 

 To install Microsoft Dynamics NAV Portal Framework for a 
specific web application on the SharePoint server, set the 
Web Application parameter to Install for one web 
application and the Port parameter to the port number of 
the web application.  

11. Specify a name and a port for Microsoft Dynamics NAV Server.  
You must have a valid Microsoft Dynamics NAV Server connection to 
successfully work with the Microsoft Dynamics NAV database. 

12. Click Apply to complete the installation. 

13. When the Setup program is finished, click Close.  
14. If SharePoint Server, Microsoft Dynamics NAV Server, and SQL Server 

database components are installed on separate computers, then you 
must set up delegation between SharePoint Server and the Microsoft 
Dynamics NAV Server. 

Verify Installation 

You can use the SharePoint Central Administration web application to view the 
status of Microsoft Dynamics NAV Portal Framework on a SharePoint web 
application. 

To verify the Microsoft Dynamics NAV Portal Framework installation, follow these 
steps: 

1. On the computer that is running SharePoint Server, click Start and 
then click All Programs. 

2. Click Microsoft SharePoint 2010 Products, and then click SharePoint 
2010 Central Administration. 

3. In Central Administration, under Application Management, click 
Manage Web Applications. 

4. Click the web application that you want to view, and then click 
Manage Features. 
The status of Microsoft Dynamics NAV Portal Configuration Feature 
should be OK and Active. 
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FIGURE 4.7: THE MANAGE WEB APPLICATION FEATURES WINDOW IN 
MICROSOFT SHAREPOINT SERVER 2010 
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Deploy and Activate Microsoft NAV Portal Framework on 
SharePoint Web Applications 

After you first install Microsoft Dynamics NAV Portal Framework on one or more 
SharePoint web applications, you can use SharePoint Central Administration to 
deploy and activate Microsoft Dynamics NAV Portal Framework on other web 
applications. When you install Microsoft Dynamics NAV Portal Framework, 
Microsoft Dynamics NAV Setup installs a SharePoint solution package for 
Microsoft Dynamics NAV Portal Framework on the server farm or stand-alone 
server. Using SharePoint Central Administration, you deploy the solution package 
to a web application. After the solution package is deployed, you must activate 
the Microsoft Dynamics NAV Portal Framework feature on the web application 
before you can start to display Microsoft Dynamics NAV content on sites of the 
web application. 

Deploy Microsoft Dynamics NAV Portal Framework to a Web 
Application 

To deploy the Microsoft Dynamics NAV Portal Framework to a SharePoint web 
application, follow these steps: 

1. Open SharePoint Central Administration. 
2. Click System Settings.  
3. On the System Settings page, under Farm Management, click 

Manage farm solutions. The Solution Management page lists all 
the solutions that are installed and available at the farm level. The 
Microsoft Dynamics NAV Portal Framework solution is 
microsoftdynamicsnavportal.wsp.  

4. Click microsoftdynamicsnavportal.wsp.   
5. On the Solution Properties page, click Deploy Solution.  
6. On the Deploy Solution page, in the Deploy When? section, click 

Now to deploy the solution immediately, or At a specified time to 
deploy the solution later. If you click At a specified time, then use 
the calendar button and time boxes to set the date and time to 
deploy the solution.  

7. In the Deploy to? section, in the Choose a Web application to 
deploy this solution field, enter the web application to deploy to.  

8. Click OK to start the deployment. 

When the deployment is completed, the Solution Management page appears. If 
Microsoft Dynamics NAV Portal Framework is deployed successfully, the Status of 
microsoftdynamicsnavportal.wsp is Deployed. 
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Activate Microsoft Dynamics NAV Portal Framework on a Web 
Application 

After you have deployed the Portal Framework solution, you can activate it on a 
web application. To activate the it, follow these steps : 

1. Open SharePoint Central Administration. 
2. Click Application Management.  
3. On the Application Management page, under Web Applications, 

click Manage web applications. 

The Web Applications page lists all the SharePoint web applications 
that are available on the server. 

4. Select the web application, and then, in the ribbon, click Manage 
Features. 

5. In the Manage Web Application Features window, click Activate. 
6. When Microsoft Dynamics NAV Portal Framework is activated, the 

Status changes to Active. 
7. Click OK when done. 

Set Up Delegation 

When SharePoint Server, Microsoft Dynamics NAV Server, and SQL Server 
database components for Microsoft Dynamics NAV are installed on separate 
computers, you must configure delegation between SharePoint Server and 
Microsoft Dynamics NAV Server. Delegation works as follows: a front-end service 
forwards a client request to a back-end service so that the back-end service can 
also impersonate the client. Impersonation is typically used to check whether a 
client is authorized to perform a particular action, whereas delegation is a way of 
flowing impersonation capabilities, together with the client’s identity, to a back-
end service. You can use delegation as a Windows domain feature with Kerberos-
based authentication. 

Configuring delegation means explicitly configuring the Microsoft Dynamics NAV 
Server service to delegate its access to the database server on behalf of Microsoft 
Dynamics NAV Portal. To make the access more secure, specify delegation to a 
specific service on a specific server.  
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To complete the procedure in this topic, you must be a domain administrator. 

To set up delegation from SharePoint Server onto Microsoft Dynamics NAV 
Server, follow these steps  

1. On any server in the domain, click Start and then click Run. 
2. In the Open field, type "dsa.msc". 

This opens the Active Directory Users and Computers utility.  

3. In the navigation pane on the left, expand the node for the domain 
where you have installed the Microsoft Dynamics NAV environment.  

4. To configure delegation, the functional level for the domain must be 
Windows Server 2003 or a later version. To verify the domain 
functional level, right-click the node for the domain where you have 
installed Microsoft Dynamics NAV, and then click Raise Domain 
Functional Level. If the level is not at least Windows Server 2003, 
then raise it to that level.  

5. Expand the Computers node, right-click the computer that is running 
Microsoft Dynamics NAV Portal Framework for Microsoft SharePoint 
2010, and then click Properties.  

6. On the Delegation tab, click Trust this user for delegation to specified 
services only and then click Use Kerberos only.  
You must add the following services for the computer that is running 
Microsoft Dynamics NAV Server: 

Service Type User or Computer Port 

DynamicsNAV NAVSERVER 7046 

Host NAVSERVER  

NAVSERVER is the name of the computer that is running Microsoft 
Dynamics NAV Server.   

7. To add the services, click Add. 
8. In the Add Services window, click Users or Computers. 
9. In the Enter the object names to select box, type the name of the 

Microsoft Dynamics NAV Server computer, and then click OK.  
10. In the list of available services, press and hold the CRTL key, select 

DynamicsNAV for port number of the Microsoft Dynamics NAV 
Server and HOST, and then click OK. 

11. Click OK to close the dialog box. 
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    Note: If the account running the Microsoft Dynamics NAV server does not 
have sufficient rights to register an SPN on startup, a message is added in the 
Windows Event Log of the NAV Server computer and the SPN must be registered 
manually. 

Configure Portal Framework after Setup 

After you install Microsoft Dynamics NAV Portal Framework, configuration 
settings are stored in the web.config files of the SharePoint applications. 

Each SharePoint application has its own web.config file. By default, the web.config 
file is located on the computer that is running Microsoft SharePoint Foundation 
Server 2010 in the c:\inetpub\wwwroot\wss\VirtualDirectories\portnumber folder. 
The portnumber indicates the port that is assigned to the web application. For 
information about identifying a port number, see the Prepare the Installation 
topic in this lesson. 

When you install Microsoft Dynamics NAV Portal Framework on a SharePoint 
application, the web.config file is modified to include a <DynamicsNAVSettings> 
tag. The <DynamicsNAVSettings> tag contains several settings that configure the 
communication between Microsoft Dynamics NAV Portal Framework and 
Microsoft Dynamics NAV Server. 

Settings in the Web.Config File 

The web.config file is an .xml file that you can edit by using any text editor. 

The following table describes the settings that are available in the 
<DynamicsNAVSettings> tag of web.config file. 

Setting Description 

AllowNtlm Specifies whether NT LAN Manager (NTLM) fallback is 
permitted for authentication. 

To require Kerberos authentication, set this value to 
false. 
Values: true, false 

Default value: true 

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Installation and Configuration in Microsoft Dynamics® NAV 2013 

4 - 36 

Setting Description 

ClientServicesChunkSize Sets the maximum size, in kilobytes, of a data chunk that 
is transmitted between Microsoft Dynamics NAV Portal 
Framework and Microsoft Dynamics NAV Server. Data 
that is transmitted between Microsoft Dynamics NAV 
Portal Framework and Microsoft Dynamics NAV Server is 
broken down into smaller units called chunks and then 
reassembled when it reaches its destination. 
Values: Between 4 and 80. 
Default: 28. 

ClientServicesCompressionThr
eshold 

Sets the threshold in memory consumption at which 
Microsoft Dynamics NAV Portal Framework starts 
compressing data sets. This limits amount of consumed 
memory. The value is in kilobytes. 

Default: 64 

ClientServicesPort Specifies the TCP port for the Microsoft Dynamics NAV 
Server. This is part of the Microsoft Dynamics NAV 
Server’s URL. 

Values: 1-65535 
Default value: 7046 

ClientServicesProtectionLevel 
 

Specifies the security services used to protect the data 
stream between the Microsoft Dynamics NAV Portal 
Framework and Microsoft Dynamics NAV Server. This 
value must match the value that is specified in the 
Microsoft Dynamics NAV Server configuration file. For 
more information, see the Configuration topic in the 
Microsoft Dynamics NAV Server lesson in the Microsoft 
Dynamics NAV Server module. 

Values: EncryptAndSign, Sign, None 
Default value: EncryptAndSign 

Company Sets the company in Microsoft Dynamics NAV to 
connect to. If you do not define a company, then the 
company currently used by the RoleTailored client for 
Windowsfor the user is used. 
Values: A company defined in the Microsoft Dynamics 
NAV solution. 
Default value: none 
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Setting Description 

HelpURL Specifies the URL that is opened by the Microsoft 
Dynamics NAV Help action. This is available on Microsoft 
Dynamics NAV pages in SharePoint sites that are running 
Microsoft Dynamics NAV Portal Framework. By default, 
the URL targets the Microsoft Dynamics NAV 2013 Help 
in the MSDN library at www.msdn.com. This is a public 
website. Therefore, to view the help, users must have 
permission to access the Internet or the default help URL 
as a minimum. 
Default value: 
http://go.microsoft.com/fwlink/?LinkID=233742 

Language Sets the language version of Microsoft Dynamics NAV 
objects to display on Microsoft SharePoint sites of a web 
application. For more information about languages, see 
Languages and Regional Settings. 
Values: Any languages that are available for the 
Microsoft Dynamics NAV solution. 

Default value: en-US 

Server Specifies the name of the computer that is running the 
Microsoft Dynamics NAV Server. 

Default value: localhost 

ServerInstance Specifies the name of the Microsoft Dynamics NAV 
Server instance to which the Microsoft Dynamics NAV 
Portal Framework connects. 
For more information, see the NAV Server 
Administration Tool topic in the Server Administration 
lesson in the Microsoft Dynamics NAV Server module. 

Default value: DynamicsNAV 

ServicePrincipalNameRequired If this parameter is set to true, then the Microsoft 
Dynamics NAV Portal Framework can only connect to a 
Microsoft Dynamics NAV Server instance that is 
associated with a service principal name (SPN). 
If this parameter is set to false, then the Microsoft 
Dynamics NAV Portal Framework tries to connect to the 
configured Microsoft Dynamics NAV Server service, 
regardless of whether that service is associated with an 
SPN. 
For more information about SPNs, see the topic "Set Up 
Delegation." 
Default: false 
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Setting Description 

SessionTimeout Specifies the maximum time that a connection between 
the Microsoft Dynamics NAV Portal Framework and the 
Microsoft Dynamics NAV Server can remain idle before 
the session is ended.  
On a SharePoint site, this setting determines how long 
an open Microsoft Dynamics NAV page can remain 
inactive before it closes. For example, when the 
SessionTimeout is set to 20 minutes, if a user does not 
take any action on a page within 20 minutes, then the 
page closes and it is replaced with the following 
message: "The page has expired and the content cannot 
be displayed." 
The time span has the format [dd.]hh:mm:ss[.ff]: 
• dd is the number of days 

• hh is the number of hours 

• mm is the number of minutes 

• ss is the number of seconds 

• ff is fractions of a second 

Default value: 00:20:00 

ShowReportViewerExportOpti
ons 

This parameter applies to the Print Preview for Microsoft 
Dynamics NAV reports on SharePoint sites. It specifies 
whether to show the options for saving a report as a 
Microsoft Excel, Microsoft Word, or Acrobat (PDF) file. 
If this parameter is set to true, then the save as Excel, 
Word, and PDF options appear in the Print Preview. 
Default: false 

    Note: To display reports, Microsoft Report Viewer 
must be configured in the web.config file of the 
SharePoint application. By default, Microsoft Report 
Viewer is configured. For more information, see the Help 
topic “How to: Configure Microsoft Report Viewer on a 
Microsoft SharePoint Application." 
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Setting Description 

UnknownSpnHint Specifies whether to use server principal name when 
establishing the connection between the Microsoft 
Dynamics NAV Portal Framework and Microsoft 
Dynamics NAV Server. This setting is used to 
authenticate the Microsoft Dynamics NAV Server, and it 
prevents the Microsoft SharePoint Foundation server 
from restarting when it connects to Microsoft Dynamics 
NAV Server for the first time. You set the value, 
depending on the value of the 
ServicePrincipalNameRequired key.  

Value: The value has the following format: 
 
(net.tcp://NavServer:Port/ServerInstance/Service)=NoSpn|
SPN 

• NavServer is the name of the computer that is 
running the Microsoft Dynamics NAV Server. 

• Port is the port number on which the Microsoft 
Dynamics NAV Server is running. 

• ServerInstance is the name of the Microsoft 
Dynamics NAV Server instance. 

• NoSpn|SPN specifies whether to use an SPN. If the 
ServicePrincipalNameRequired key is set to false, 
then set this value to NoSpn. If the 
ServicePrincipalNameRequired key is set to true, 
then set this value to Spn. 

Default value: 
(net.tcp://localhost:7046/DynamicsNAV/Service)=NoSpn 
If you set this key to the wrong value, then during 
startup, the Microsoft Dynamics NAV Portal Framework 
determines a correct value automatically. This causes the 
Microsoft SharePoint Foundation Server to restart. 

    Note: For most installations, you do not have to 
change this value. Unlike the RoleTailored client, this 
setting is not updated automatically. If you want to 
change the default value, you must change it manually.  
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Support Wide Area Network Connections 

Deployment Scenario 

The Microsoft Dynamics NAV 2013 RoleTailored client for Windows supports 
secured connections to Microsoft Dynamics NAV Server over a wide area network 
(WAN). In this scenario, the RoleTailored client for Windows and Microsoft 
Dynamics NAV Server can be in the same or separate Active Directory domains. 

Implementing secured client connections over a WAN requires administration on 
both the Microsoft Dynamics NAV Server and the client. The previous module 
describes the different steps that are needed to configure the Microsoft Dynamics 
NAV Server to support WAN connections: 

• Create a root certification authority (CA) and a server certificate.  

• Install the server certificate on the Microsoft Dynamics NAV Server 
computer. 

• Create a certificate revocation list for the root CA. 

• Install the certificate revocation list on the Microsoft Dynamics NAV 
Server. 

• Grant access to the certificate’s private key to the service account of 
Microsoft Dynamics NAV Server.  

• Modify the configuration file to support logon over a WAN. 

For more information about certificates, see the Wide Area Network Connections 
topic in the, "Microsoft Dynamics NAV Server". 

This module describes how to configure the Microsoft Dynamics NAV Server to 
support logon over a WAN.  

    Note: Implementing remote logon requires changing the credential type for 
the Microsoft Dynamics NAV Server instance involved. Consider using a dedicated 
Microsoft Dynamics NAV Server instance for remote connections so that this 
change does not affect local users. 

Configure Client Computer 

With the chain trust configuration, only the root CA and the certificate revocation 
list must be installed for the client computer. Afterward, you must modify the 
client configuration file.  
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Install the Root CA on the Client Computer 

This procedure is identical to the procedure for installing the root CA on the 
Microsoft Dynamics NAV Server.  

1. On the client, on the Windows Taskbar, click Start > Run. 
2. In the Run dialog box, enter the following command: 

mmc 

3. In Microsoft Management Console, click File > Add/Remove Snap-
in. 

4. In the Add or remove snap-ins dialog box, in the Available snap-
ins list, select Certificates and then click Add.   

5. In the Certificates snap-in dialog box, click Computer account and 
then click Next. 

6. In the Select Computer pane, click Local computer: (the computer 
this console is running on) and then click Finish. 

7. Click OK to close the Add or Remove Snap-ins dialog box. 
8. In the left pane of MMC, expand the Certificates (Local Computer) 

node. 

9. Expand the Trusted Root Certification Authorities node, right-click 
the Certificates subfolder, select All Tasks, and then click Import. 

10. In the Certificate Import Wizard, on the Welcome page, click Next. 
11. On the File to Import page, click Browse. 
12. Locate the RootNavServiceCA.cer certificate file, select the file, and 

then click Open. 
13. On the File to Import page, click Next. 
14. On the Certificate Store page, accept the default selection, and then 

click Next. 
15. On the Completing the Certificate Import Wizard page, click 

Finish. 

Install the Certificate Revocation List on the Client Computer 

After you have installed the root CA, you must also install the certificate 
revocation list on the client. A certificate revocation list is required because WCF 
applications check the revocation list when validating certificates. 

1. On the client, on the Windows Taskbar, click Start > Run. 
2. In the Run dialog box, enter the following command: 

mmc 
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3. In Microsoft Management Console, click File > Add/Remove Snap-
in. 

4. In the Add or remove snap-ins dialog box, in the Available snap-
ins list, select Certificates and then click Add.   

5. In the Certificates snap-in dialog box, click Computer account and 
then click Next. 

6. In the Select Computer pane, click Local computer: (the computer 
this console is running on) and then click Finish. 

7. Click OK to close the Add or Remove Snap-ins dialog box. 
8. In the left pane of MMC, expand the Certificates (Local Computer) 

node. 
9. Expand the Trusted Root Certification Authorities node, right-click 

the Certificates subfolder, select All Tasks, and then click Import. 
10. In the Certificate Import Wizard, on the Welcome page, click Next. 
11. On the File to Import page, click Browse. 
12. In the File Type field, select Certificate Revocation List (*.crl). 
13. Locate the RootNavServiceCA.crl certificate revocation lost file, select 

the file, and then click Open. 

14. On the File to Import page, click Next. 
15. On the Certificate Store page, accept the default selection and then 

click Next. 
16. On the Completing the Certificate Import Wizard page, click 

Finish. 

Modify the Client Configuration File to Support WAN Logins 

The RoleTailored client for Windows and Microsoft Dynamics NAV Server must be 
configured to use the same credential type. The default credential type for the 
RoleTailored client for Windows is Windows. In a WAN connection deployment, 
the credential type must be changed to Username. In addition, you must add 
certificate information.  

The client configuration cannot be changed by using the Server Administration 
Tool. To modify the client configuration file, you must edit it using a text editor, 
for example Notepad.  

In Windows 7, Windows Vista, or Windows Server 2008, the location of the client 
configuration file is C:\Users\<username>\AppData\Local\Microsoft\Microsoft 
Dynamics NAV (where username represents the Windows user name).  By default, 
this file is hidden. Therefore, you may have to change your folder options in 
Windows Explorer to view hidden files. 

1. Open the ClientUserSettings.config configuration file. 
2. Modify the following settings. 
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Key New Value Description 

ClientCredentialType UserName The Default value is Windows. 
When you change it to 
UserName, users who connect 
to the server are prompted for 
user name and password 
credentials. 

DnsIdentity The subject 
name of the 
server 
certificate. 

The default value is <identity>. 

You should set the key to match 
the subject name of the server 
certificate.  
 
When you create a server 
certificate by using the 
makecert.exe tool, you can 
specify the subject name by 
adding the –n parameter. 

 

3. Save and close the ClientUserSettings.config file. 

When you start the RoleTailored client for Windows, you are prompted for a valid 
user name in the format domain\username and password for the server domain 
(even if the client computer is in the same as the Microsoft Dynamics NAV server). 

Add Client Languages 
Explain how to install additional interface languages for Microsoft Dynamics NAV 
2013.  

Use Language Modules 

In a Multilanguage-enabled application such as the RoleTailored client for 
Windows, you can view the text in any language that is added to the application. 

To view Microsoft Dynamics NAV 2013 in multiple languages, install one or more 
language modules. This topic describes language modules in Microsoft Dynamics 
NAV 2013. 

A language module contains the following: 

• Translated strings for the user interface (UI) in the Development 
environment. 
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• Translated strings for the UI in the RoleTailored client for Windows. 

• Translated strings for the database. 

• Translated strings for Microsoft Dynamics NAV Server, such as for logs 
and error reporting. 

• Translated strings for the Microsoft Office Outlook Add-in for 
Microsoft Dynamics NAV. 

• Translated strings for charts on Role Centers in the RoleTailored client 
for Windows. 

• Localized versions of the client Help. 

Language modules are binary files that you cannot modify with external tools. 

If you have customized Microsoft Dynamics NAV 2013, then after you install the 
appropriate language module, you should also translate the strings for the objects 
that you added or modified. This is covered in the course C/SIDE Introduction in 
Microsoft Dynamics NAV 2013.  

Language Subfolder 

When you install a language module, a subdirectory for the language is created in 
the Microsoft Dynamics NAV folder structure. The .stx, .etx, .chm, and .hh files for 
each language are automatically installed in the subfolder. The name of the 
subdirectory is the three-letter language code (abbreviated name) that is used by 
Windows for the particular language.  

Install Language Modules 

To install language modules in Microsoft Dynamics NAV 2013, you must first 
download the language module from the Language Modules for Microsoft 
Dynamics NAV 2013 website. (This requires a PartnerSource logon.) Afterward you 
install the following different components separately: 

• Server  

• RoleTailored client for Windows  

• Development environment  

• Database  

• (optional) Microsoft Office Outlook  
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Server Component 

To install the server component of a language module, follow these steps: 

1. On the computer that is running Microsoft Dynamics NAV Server, 
locate where you downloaded the language module.  

2. Run the .exe file to unzip the language module files. 

3. In the Server folder, run Server.Local.<country/region 
code>.<language code>.msi.  

4. In Control Panel, click Administrative Tools, and then click Services 
to open the Services snap-in. 

5. In the list of services, right-click Microsoft Dynamics NAV Server 
and then click Restart. 

RoleTailored Client Component 

To install the RoleTailored client component of a language module, follow these 
steps: 

1. Confirm that you have installed the server component of the 
language module before you install the RoleTailored client 
component. 

2. On the computer that is running the RoleTailored client, locate where 
you downloaded the language module.  

3. In the RoleTailoredClient folder, run 
RoleTailoredClient.Local.<country/region code>.<language code>.msi. 

4. (optional) To import a localized chart for a Role Center, do the 
following: 
a. In the development environment client, open Object Designer. 

b. On the File menu, click Import.  
c. In the Import Objects window, locate where you downloaded the 

language module, browse to the RoleTailored Client folder, and 
then locate the Charts folder. 

d. Select the chart that you want to add to a Role Center, and then 
click Open. 

By default, this overwrites an existing chart page that has the 
same ID. 

e. Personalize a Role Center to use the chart part. 
  

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Installation and Configuration in Microsoft Dynamics® NAV 2013 

4 - 46 

Development environment Component 

To install the development environment component of a language module, follow 
these steps: 

1. On the computer that is running the development environment, 
locate where you downloaded the language module.  

2. In the ClassicClient folder, run ClassicClient.Local.<country/region 
code>.<language code>.msi.  

3. Install the database component of the language module by using the 
following procedure. 

Database Component 

To install the database component of a language module, follow these steps: 

1. Verify that the license that you are using allows you to compile 
objects. 

2. In the development environment client, open Object Designer. 
3. In Object Designer, click All. 
4. On the Edit menu, click Select All. 
5. On the Tools menu, point to Language Module and then click 

Import. 
6. In the Language Module Import window, locate where you 

downloaded the language module, browse to the Database folder, 
select the .flm file, and then click Open. 

7. With all objects selected, on the Tools menu, click Compile. 

Microsoft Office Outlook Component 

To install the Microsoft Office Outlook component of a language module, follow 
these steps: 

1. On the computer that is running the development environment, 
locate where you downloaded the language module.  

2. In the OutlookAddIn folder, run OutlookAddIn.Local.<country/region 
code>.<language code>.msi.  
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Lab 4.1: Create a Setup Configuration  File 
Scenario 

Tim wants to install the RoleTailored client for Windows on five computers in the 
network. On four computers he wants to install the RoleTailored client for 
Windows without the Development environment. On one computer, he wants to 
install the RoleTailored client for Windows together with the Development 
environment. The Microsoft Office Excel Add-in and Microsoft Office Outlook 
Add-in will be installed on all computers. Tim starts by creating a Setup 
configuration file that he can use to do the installation. 

Because the new computers have not been delivered yet, Tim prepares the Setup 
configuration file on the Microsoft Dynamics NAV Server computer. 

Exercise 1: Create Setup File 

Task 1: Start Microsoft Dynamics NAV Setup 

High Level Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 
2. Start Microsoft Dynamics NAV Setup. 

Detailed Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 

a. Open the DVD drive by pressing the Eject button on the physical 
drive. 

b. Put the DVD on the tray. 
c. Press the Close button to close the DVD drive. 

 
2. Start Microsoft Dynamics NAV Setup. 

a. Open Windows Explorer. 

b. Select Computer in the left pane to see a list of available drives. 
c. Select the DVD drive that contains the product DVD.  
d. In the root folder of the selected drive, double-click setup.exe. 
e. If the Open File - Security Warning dialog box appears (asking 

whether you want to run the setup.exe application), click Run. 
  

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Installation and Configuration in Microsoft Dynamics® NAV 2013 

4 - 48 

Task 2: Select the Installation Option 

High Level Steps 
1. Select the installation option. 

Detailed Steps 
1. Select the installation option. 

a. In the Welcome to the Microsoft Dynamics NAV 2013 Setup 
window, on the Maintenance page, select Add or remove 
components. 

b. On the Customize the installation page, click the Client node to 
expand it.  

c. Click the icon at the left of the Development environment 
(C/SIDE) component. 

d. Select Not Available. 
e. Click the icon at the left of the Microsoft Office Excel Add-in 

component. 

f. Select Run from My Computer. 
g. Click the icon at the left of the Microsoft Office Outlook Add-in 

component. 
h. Select Run from My Computer. 
i. Click the icon at the left of the Administration Tool node. 
j. Select Not Available. 
k. Repeat the previous two steps for the Documentation, Server, 

SQL Server Database Components, Portal Framework for 
SharePoint, Automated Data Capture Systems, NAV Web 
Server Components, and ClickOnce Installer Tools 
components.  

l. On the Customize the installation page, click Next. 

Task 3: Specify Configuration Parameters 

High Level Steps 
1. Specify configuration parameters. 

Detailed Steps 
1. Specify configuration parameters. 

a. On the Specify parameters page, in the Server Name field, 
enter NAV-DC-SQL-SP.   

b. Verify that the Client Services Port is set to 7046 and the Add 
rule to Firewall field is set to Yes.  
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Task 4: Save the Configuration File 

High Level Steps 
1. Save the configuration parameters to file. 

Detailed Steps 
1. Save the configuration parameters to file. 

a. On the Specify Parameters page, click Save. 
b. In the Save As dialog box, browse to the Desktop folder. 

c. In the File Name box, enter the name of the configuration file. 
We recommend that you use short but meaningful names. In this 
case, enter NAV2013_RTC_Live. 

d. In the Save As dialog box, click Save. 

e. On the Specify Parameters page, click Close to exit Microsoft 
Dynamics NAV 2013 Setup. 

f. In the Setup dialog box, click Yes. 
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Lab 4.2: Set Up the RoleTailored Client for Windows 
from the Command Line 

Scenario 

The new computers were delivered. Tim has added the computers to the domain 
and has installed Microsoft Office. He also copied the Microsoft Dynamics NAV 
2013 Product DVD to a shared folder (called SOFTWARE) on the NAV-DC-SQL-SP 
server and copied the NAV2013_RTC_Live.xml Setup configuration file to the local 
c:\temp folder on each of the five computers. He can now start to install the 
RoleTailored client for Windows.  

Exercise 1: Install the RoleTailored Client for Windows 
without the Development environment 
Exercise Scenario 

Tim wants to install the RoleTailored client for Windows without the Development 
environment component on four computers. He can use the Setup configuration 
file from the previous lab to do this. Because he does not want to run through the 
Setup wizard on each computer, he decides to run Setup by using the command 
prompt and in quiet mode. If he does this, he does not have to run through the 
Setup wizard manually.  

Task 1: Open a Command Prompt 

High Level Steps 
1. Open a command prompt. 

Detailed Steps 
1. Open a command prompt. 

a. On the Windows Taskbar, click Start > All Programs > 
Accessories > Command Prompt.  

Task 2: Start Microsoft Dynamics NAV Setup 

High Level Steps 
1. Start Microsoft Dynamics NAV Setup. 

Detailed Steps 
1. Start Microsoft Dynamics NAV Setup. 

a. Enter the following command: 

\\NAV-DC-SQL-SP\software\setup.exe /config “c:\temp\NAV2013_RTC_Live.xml” 
/quiet  
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b. Wait for the Setup program to finish.  

Task 3: Close Command Prompt 

High Level Steps 
1. Close the command prompt. 

Detailed Steps 
1. Close the command prompt. 

a. At the command prompt, type "exit" and press Enter to close the 
command prompt window 

Exercise 2: Install the RoleTailored Client for Windows 
Together with the Development environment 
Exercise Scenario 

Tim must install the RoleTailored client together with the Development 
environment component on one computer. He wants to use the same Setup 
configuration file to do this, because it contains the correct configuration 
parameters for the RoleTailored client for Windows. However, because the 
Development environment component was not selected when the configuration 
file was created, Tim must customize this installation.  

Task 1: Open a Command Prompt 

High Level Steps 
1. Open a command prompt. 

Detailed Steps 
1. Open a command prompt. 

a. On the Windows Taskbar, click Start >All Programs 
>Accessories > Command Prompt.  
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Task 2: Start Microsoft Dynamics NAV Setup 

High Level Steps 
1. Start Microsoft Dynamics NAV Setup. 

Detailed Steps 
1. Start Microsoft Dynamics NAV Setup. 

a. Enter the following command: 

\\NAV-DC-SQL-SP\software\setup.exe /config “c:\temp\NAV2013_RTC_Live.xml” 

Task 3: Customize the Installation 

High Level Steps 
1. Choose the installation option. 

Detailed Steps 
1. Choose the installation option. 

a. In the Microsoft Dynamics NAV 2013 Setup window, click 
Next. 

b. On the Microsoft Software License Terms page, click I Accept. 
c. On the Microsoft Dynamics NAV Setup page, click Customize 

installation.  
If you select Install preconfigured Product components, Setup 
installs the product components exactly as saved in the Setup 
configuration file. Because the Development environment 
(C/SIDE) component was not selected in the configuration file, 
you must customize the installation. Therefore, click Customize 
installation. 

d. On the Customize the installation page, click the Client node to 
expand it.  

e. Click the icon at the left of the Development environment 
(C/SIDE) component. 

f. Select Run from My Computer. 
g. On the Customize the installation page, click Next. 
h. On the Specify parameters page, click Apply.  
i. Click OK to close the Microsoft Dynamics NAV Setup window. 
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Task 4: Close Microsoft Dynamics NAV Setup 

High Level Steps 
1. Exit Microsoft Dynamics NAV Setup. 

Detailed Steps 
1. Exit Microsoft Dynamics NAV Setup. 

a. Click Close to close the Microsoft Dynamics NAV Setup 
window. 
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Module Review 
Module Review and Takeaways 

This module describes the installation of Microsoft Dynamics NAV 2013 client 
types. As an administrator, it is helpful to know the following: 

1. How to install the full RoleTailored client for Windows 
for demonstration purposes. 

2. How to install the RoleTailored client for Windows on a network. 
3. How to install the Microsoft Dynamics NAV Web client. 
4. How to install the Microsoft Dynamics NAV Portal Framework for 

Microsoft SharePoint.  
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